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Questo documento fornisce informazioni per l’installazione di  
eScan e fornisce una guida rapida per usare i comandi principali. 
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Guida utente di eScan  

Il software descritto in questo manuale é fornito con un accordo di licenza e può essere utilizzato esclusivamente in accordo con i termini descritti. 

Numero Documento: 2NESQRG04/15.12.04 

Copyright  

Copyright (C) 2004. Tutti i diritti riservati. 

Portions (C) by Kaspersky Labs International Limited. 

Qualsiasi documentazione tecnica resa disponibile da MicroWorld é protetta da copyright di MicroWorld e proprietaria di MicroWorld. 

NO GARANZIA. La documentazione tecnica é  trasmessa così COME E’ e MicroWorld non si assume la responsabilità della sua accuratezza 
dell’uso che ne viene fatto. Qualsiasi uso della documentazione tecnica o delle informazioni in essa contenuta è a vostra completa responsabilità. 

La documentazione può includere errori tecnici o di altra natura o errori di tipografia. MicroWorld si riserva il diritto di compiere dei cambiamenti 
senza dare priorità di preavviso. 

Nessuna parte della presente documentazione può essere copiata senza il permesso esplicito scritto di MicroWorld. 

Marchi registrati. 

MicroWorld, MicroWorld Logo, eScan, eScan logo, MWL, MailScan sono marchi registrati di MicroWorld. 

Windows é un marchio registrato di Microsoft Corporation; Kaspersky é un marchio registrato di  Kaspersky Labs. 

Tutti i nomi dei prodotti si riferiscono a loro volta ai relativi marchi registrati o marchi registrati delle relative aziende. MicroWorld Software Services 
Pvt. Ltd. (MicroWorld) non si ritiene responsabile dei marchi e dei nomi degli altri produttori citati. Sebbene MicroWorld faccia il possibile per 
assicurare che le informazioni fornite siano corrette, MicroWorld non si ritiene responsabile per eventuali errori od omissioni o fatti contenenti tali. 
MicroWorld Software Services Pvt. Ltd. Si riserva il diritto di modificare le specifiche menzionate in questo documento senza alcun preavviso. 

Aziende, nomi e qualsiasi informazione usata negli esempi é di pura invenzione dove non diversamente specificato. 

Nessuna parte di questo documento può essere riprodotta o trasmessa in qualsiasi forma o modo sia esso meccanico, elettronico, per qualsiasi scopo, 
senza il permesso scritto esplicito di MicroWorld Software Services Pvt. Ltd. 

Altri nomi di prodotti menzionati in questo manuale possono essere marchi o marchi registrati delle rispettive aziende proprietarie e sono da loro 
riconosciuti. 

Supporto Tecnico:  support@mwti.net 

Vendita:   sales@mwti.net 

Stampato: MicroWorld 

Dicembre, 2004 
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List Caratteristiche dei Prodotti eScan  

Prodotto eScan  Caratteristiche disponibili 

eScan Anti-Virus 
Edition 

eScan Updater, MWL Scanning, Real-time email Scanning 

eScan Virus Control 
Edition 

On Demand Scanner, eScan Updater, eScan Anti-Virus 
Monitor, MWL Scanning, Real-time email Scanning, email 
Attachment Control, Scan Web pages, Allow Notifications 

to users  

eScan Professional 
Edition 

On Demand Scanner, eScan Updater, eScan Anti-Virus 
Monitor, MWL Scanning, Real-time email Scanning, email 
Attachment Control, Scan Web pages, Allow Notifications 

to users, Assign Remote Access File Rights. 

eScan Internet 
Security Edition 

On Demand Scanner, eScan Updater, eScan Anti-Virus 
Monitor, Block PopUp, Browser Cleanup, MWL Scanning, 
Real-time email Scanning, email Attachment Control, Scan 
Web pages, Allow Notifications to users, Assign Remote 

Access File Rights 

 

 

A l cu n e  p a r o l e  p r ima  d i  i n i z i a r e  

MicroWorld vi dà il benvenuto! 

eScan fornisce la migliore protezione contro i virus, Trojans, Worms e e altri infezioni che si trovano in Internet. Anticipa la prossima generazione di 
prodotti software Anti-Virus che trattano le infezioni sotto una nuova prospettiva. E’ basato sulla tecnologia MicroWorld Winsock Layer (MWL). 
MWL va a formare una schermo protettivo attorno al vostro sistema ed é sempre in guardia dal momento in cui accendete il vostro computer, fino a 
che lo spegnete. Installare eScan come prima cosa. La sezione “Installazione di eScan” fornisce informazioni dettagliate con utili screen shots per 
aiutarvi nell’installazione di eScan 

Alcune importanti caratteristiche sono elencate di seguito: 

Anti-Virus Engine – Motore di detection virus intelligente, trova ed elimina le infezioni al volo. 

Content Security e Parental Control– Blocca i siti porno e altri 

Block Spam – Blocca le mail di spam 

Block Attachment – Specifica i tipi di allegati che devono essere bloccati automaticamente  

Heuristic Scan Engine – Trova i virus sconosciuti 

Auto-download Updates – Download automatico degli aggiornamenti gratuiti dai siti di MicroWorld  

E molto altro ancora……. 

Vi ringraziamo per aver scelto eScan 

 

Installazione di eScan 

Questa sezione fornisce informazioni circa i Requisiti software e hardware del vostro sistema per installare eScan e fornisce istruzioni passo-passo per 
la relativa installazione.  

Requ i s i t i  S o f twa r e  e  Ha r dwa r e   
 
Il Vostro sistema deve avere  Windows 95/98/ME/NT/2000 /XP/2003 

Requisiti minimi di 32 MB RAM, 50 MB di spazio libero sul disco rigido e possedere un lettore CD ROM. 

 

P r e r e qu i s i t i  p e r  l ’ I n s t a l l a z i o n e  
 
Prima di installare il software assicuratevi dei seguenti prerequisiti: 

• Il Vostro sistema deve avere  Windows 95/98/ME/NT/2000/XP/2003. 

• Requisiti minimi di 32 MB RAM, 50 MB di spazio libero sul disco rigido e possedere un lettore CD ROM. 



M i c r o W o r l d  T e c h n o l o g i e s  I n c .  

w w w . m w t i . n e t  

e S c a n  Q u i c k  R e f e r e n c e  G u i d e                                       6666                  

 

Altri prerequisiti sono: 

Prima di installare il software assicuratevi dei seguenti prerequisiti: 

• Disinstallare qualsiasi versione di software Anti Virus, comprese le versioni precedenti dei nostri prodotti (Versioni 180 e 
precedenti). 

 
• Verificare per lo spazio libero sul disco / partizione e installare eScan sul drive / partizione con maggior spazio libero. 

 
Note: Per Windows NT,  é richiesto service pack 5 o maggiore. 

• Necessario diritti di amministratore per accedere al PC.  
 

• Indirizzo IP del Mail Server, dove i messaggi di warning devono essere spediti. Se il Mail Server necessita di autenticazione 
obbligatoria per accettare e-mail, allora é necessario possedere user name e password per spedire le mail. 

 

P r oc edu r a  d i  I n s t a l l a z i o n e  

Il software vi é spedito in un CD. Caricate il CD nel drive e aprite la cartella CD ROM. Viene attivato un piccolo filmato che vi mostra un preview 
delle caratteristiche chiave di eScan. Potete cliccare sul link “Skip Intro” per andare direttamente all’installazione. Per annullare l’installazione, 
selezionare “Cancel” in una qualsiasi delle finestre. Questa sezione vi guida passo-passo nel processo di installazione. 

 

 
                      

Passo 1 

Accettare la licenza per proseguire. 
Cliccare Yes. 

 

Passo 2 

Viene mostrata la directory di 
installazione di Default. 
Selezionare Next o sfogliare per 
un’altra destinazione. 

 

Passo 3 

Pronti per l’installazione. Cliccare 
Install. 

 

Passo 4 

Vengono estratti i files necessari per 
l’installazione. Vengono mostrare 
automaticamente una serie di finestre. 
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Passo 5 

Vengono scaricati gli ultimi 
aggiornamenti disponibili. 

 

 

 Passo 6 

MicroWorld Anti-Virus Toolkit é 
attivo. Il vostro sistema e i files di 
registro vengono verificati e analizzati 
per cercare virus nascosti.  

 

 

Passo 7 

Inserire la chiave di Licenza. Se volete 
installare una versione di prova (trial 
version) o volete inserire la chiave in 
seguito, cliccate Cancel. 

 

Passo 8 

Dovete riavviare il sistema. 
Selezionare Yes. 

Passo 9 

L’installazione é terminata. 
Selezionare Finish. 

 

 

 

 

Dopo l’installazione vedrete le seguenti icone aggiunte alla system tray, nell’angolo in basso a destra. Queste sono moduli differenti che contengono 
menu per aiutarvi ad attivare le vostre azioni. 

• Doppio click su  per avviare  eScan Anti Virus Monitor. Potete selezionare i files e le cartelle da analizzare, specificare le 
azioni da avviare come quarantena, cancellazione, quando é trovato un file infetto. 

• Tasto destro su  per aprire un popup che fornisce una serie di scorciaotoie (short cut). I moduli di eScan come On Demand 
Scanner che vi permette di eseguire la scansione del vostro sistema on demand; Content Administrator per impostare security 
policies per la vostra rete, eScan Updater per configurare le impostazioni di download automatico degli aggiornamenti che 
proteggono il vostro sistema dagli ultimi virus. Potete inoltre avviare eScan Anti Virus Monitor. I moduli sono completamente 
integrati con un sistema di help on-line disponibile nella tool bar sotto Help > eScan Content Administrator Help. 

 
eScan possiede un potente sistema di help online che fornisce informazioni dettagliate per ogni finestra e campo. Per avere informazioni circa un 
campo, pulsante o finestra di dialogo, cliccare sull’oggetto e premere F1. 

 

Usare On Demand Scanner 

On Demand Scanner vi permette di eseguire lo scan di floppies, files e directories come e quando vi serve. 

Lo  S t a t o  d i  e S c an   

La welcome screen dell’applicazione vi fornisce informazioni circa la data del corrente virus update, quando è stata fatta la scansione del vostro 
computer, se l’opzione di aggiornamento automatico è attiva e se virus monitor è attivo. 
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S c a n s i on e  d i  F l op py  
 

• Inserire il floppy nel drive apposito. 

• Tasto destro su  e selezionare Scan Floppy. 
 

S c a n s i on e  d i  F i l e s  e  D i r e c t o r i e s  
 

• Tasto destro su   e selezionare Start eScan for Windows. 

• Il modulo On Demand Scanner é attivo. Nel frame a sinistra della finestra, selezionare Actions > Check Computer. Quindi 
cliccare su Start. 

• Il Toolkit Anti-Virus di MicroWorld é attivo e potete selezionare i files e le  directories su cui eseguire la scansione. 
 

S c a n s i on e  d i  CD  ROM 
 

• Tasto destro su  e selezionare Start eScan for Windows. 

• Il modulo On Demand Scanner é attivo. Nel frame a sinistra della finestra, selezionare Actions > Check CD ROM. Quindi 
cliccare su Start. 

• Il Toolkit Anti-Virus di MicroWorld é attivo e il vostro CD ROM viene analizzato.  
 

Impos t a r e  Op z i o n i  d i  V i r u s  S c an n in g  

Questa opzione vi permette di configurare le azioni che devono essere prese durante la scansione virus. Quando vengono trovati file infetti potete 
scegliere di disinfettare i files, cancellarli, rinominarli ecc.   

• Tasto destro su  e selezionare Start eScan for Windows. Il modulo On Demand Scanner é attivo. Cliccare sul pulsante 
Options  

• Ci sono tre tab: Virus Check, Status e Restrictions 

• Virus Check vi permette di selezionare il tipo di scansione e cosa deve essere fatto quando sono trovati files infetti  

• Status vi permette di generare warnings quando gli updates sono obsoleti 

• Restrictions vi permette di impostare restrizioni per i files con specifiche estensioni, dimensioni ed escludere alcuni files dalla 
scansione  

 

Impos t a r e  S ch edu l a z i o n e  p e r  Au t o  S c a n  

• Tasto destro su   e  selezionare Start eScan for Windows. Il modulo   On Demand Scanner é attivo. Clicccare Scheduler > 
Add new task. 

• Viene visualizzata la finestra Automatic Virus Check con quattro tab.  

• Inserire i valori appropriate in tutti i Tabs. 
 

Ved e r e  i  L og  

eScan fornisce un Log dettagliato dell’attività anti virus. Cliccare su Log per vedere la finestra mostrata sotto. Vengono inoltre visualizzati la versione 
dell’applicazione di eScan Anti Virus, files e cartelle analizzate, ecc. 

 

Usare eScan Updater 

eScan Updater fornisce il download automatico degli aggiornamenti. Gli Aggiornamenti sono definizioni di virus create da MicroWorld per rimuovere 
i nuovi virus che sono apparsi o che potrebbere aver infettato il vostro sistema. Questi aggiornamenti automatici sono memorizzati nei nostri siti 
mirror dedicati . 

Se avete installato prodotti eScan tranne eScan Corporate, allora eScan Updater si connette automaticamente ai siti di download . 

Se avere installato eScan Corporate: 

• eScan é installato come Client, quindi eScan é installato come eScan Client Updater 

• eScan é installato come un Server quindi l’updater é installato come eScan Server Updater 
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S e l e z i on a r e  Mod a l i t à  d i  Down l oad  Agg i o r n amen t o  

• Tasto destro su  e selezionare eScan Updater Options or Alternate Download Settings.  Il modulo eScan Updater é attivo. 
Ci sono dei tabs nella finestra  

• In General (tab) > Select Mode, selezionare la modalità di download. Le pagine tab relative sono ora abilitate e potete configurare 
i loro settaggi .  

• Ci sono tre modalità di download disponibili: FTP (default); HTTP e UNC (per reti)  
 

Impos t a r e  S ch edu l a z i o n e  p e r  d own l oa d  

• In eScan Updater > General Config (tab), cliccare sul pulsante Scheduling. 

• Viene visualizzata la finestra Advanced Settings. Scegliere Automatic Download e specificare l’intervallo in minuti tra i successive 
download . Potete anche selezionare Scheduled Download e definire il giorno o la data in cui devono essere scaricati gli 
aggiornamenti. 

 

Agg i o r n amen t o  

• In eScan Updater > General Config (tab), cliccare sul pulsante Update now. Vengono scaricati gli Aggiornamenti. 
 

Camb i a r e  S e r v e r  

• Questa opzione viene usata quando volete specificare un nuovo server da cui scaricare gli aggiornamenti.  

• In eScan Updater > General Config (tab), cliccare sul pulsante Change Server . Inserire l’indirizzo IP del nuovo server  

•  

• Nota: Download alternativo :In eScan client updater, se il download automatico (download da Server eScan locale) fallisce, il 
client effettuerà il download degli aggiornamenti direttamente da Internet usando le impostazioni di download alternativo. Il 
download alternativo sarà operativo quando attivato e quando gli ultimi aggiornamenti risalgono a più di 1 giorno. Dopo il suo 
avvio, effettuerà la verifica degli aggiornamenti ogni ora, per poi reimpostarsi al successivo aggiornamento su automatic download. 

 

Usare Content Administrator 

La caratteristica eScan Content administrator di eScan, vi permette  di monitorare e amministrare il flusso di traffico Internet entrante e uscente del 
vostro sistema. Potete impostare security policies a: verifica traffico e-mail per specifiche parole o frasi come xxx, naked, ecc.; nega o permetti: scambio 
di tipi particolari di allegati, abilitare loro auto compressione, mandare messaggi di warning al mittente, destinatario o altri quando le security policies 
sono violate. Una caratteristica importante è la possibilità di bloccare (e permettere) l’accesso a siti specifici o pagine che contengono restrizioni sulle 
parole utilizzate.  

Altre caratteristiche che sono state aggiunte includono il menu per Popup Filter, che vi  permette di bloccare le finestre di popup prima che vengano 
mostrate sul vostro schermo e Browser CleanUp, che protegge la vostra privacy rimuovendo dal vostro sistema tutte le tracce che rimangono dopo 
una navigazione sul web in riferimento ai siti visitati  

Tasto destro su  e selezionare Start eScan Content Administrator. Il modulo eScan Content Administrator è attivo. Il frame di sinistra 
visualizza i menu che vi permettono di eseguire le seguenti azioni . 

Controllo Allegati in Email  

B l o c c a r e  g l i  a l l e g a t i   

• Cliccare su . Nel frame Block Attachment type, inserire l’estensione del tipo di allegato da bloccare (es. .exe). 

• Cliccare . Il nome dell’allegato viene mostrato nella lista.  
 

Z ip  A l l e g a t i  i n  u s c i t a .   

• Cliccare . Nel frame Configure Compression/Decompression, selezionare l’opzione Compress outbound Attachment . 
 

Canc e l l a r e  a l l e g a t i  P e r i c o l o s i   

• Cliccare . Nella finestra, cliccare . 

• Viene visualizzata una finestra con tre tab.   

• Aprire il tab IE Vulnerabilities I. Selezionare le opzioni Delete Files with CLSID Extension e Delete HTML with Scripts. 
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Canc e l l a r e  f i l e s  c o n  e s t e n s i on i  mu l t i p l e    

• Cliccare . Nella finestra, cliccare . 

• Aprire il tab IE Vulnerabilities II. Selezionare l’opzione Delete Mail. 
 

A r ch i v i a r e  Ma i l s  &  A l l e g a t i  

• Cliccare . Nella finestra, cliccare . 

• Aprire il tab Archival. Selezionare le opzioni per Archive eMails e Archive Attachment”. 
 

Content Scanning 

Ve r i f i c a  Sp am  i n  ema i l s  

• Cliccare . Selezionare l’opzione Enable Content Checking. 
 

Agg i ung e r e  P a r o l e  d a  b l o c c a r e  

• Cliccare . Nel frame Phrase To Check, inserire la frase che deve essere bloccata nel campo . 

• Cliccare . La frase viene visualizzata nella lista  . 
 

C r e a r e  D i s c l a ime r  

• Cliccare . Nel frame Disclaimer, selezionare l’opzione  Add Disclaimer to outbound Mails. 

• Cliccare sotto nella finestra, inserire il  disclaimer e cliccare Save. 

•  

Opz i o n e  d i  Ma i l  t a g g i n g  

• Cliccare  per aprire l’opzione di Mail Tagging  

• Selezionare le opzioni desiderate per le mail identificate come Spam .  

•  

Ved e r e  l e  ma i l  i n  Qua r a n t en a   

• Cliccare questo pulsante per vedere le mails in Quarantena . 
  

 

Scansione PagineWeb 

Ab i l i t a r e  S c an s i o n e  Pa g i n eWeb  

• Cliccare . Selezionare l’opzione Active  
 

B l o c c a r e  Ac c e s s o  I n t e r n e t  p e r  un  c e r t o  t empo  

• Cliccare . Selezionare . 

• Viene visualizzata la finestra Scheduling. Cliccare l’opzione Enable Time Restriction . 

• Cliccare Add. Viene visualizzata la finestra Addition / Modification of Scheduling. Selezionare Enable this Schedule. 

• Scegliere le impostazioni disponibili messe a disposizione . 
 

B l o c c a r e  P o r n o  

• Cliccare . Selezionare . Viene visualizzata la finestra Advanced.  

• Nel frame delle Opzioni Content Matching, selezionare le opzioni desiderate . 
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B l o c c a r e  Immag in i ,  Me s s a g g i  (RFC  8 2 2 ) ,  App l i c a z i on i  

• Cliccare . Selezionare . Viene visualizzata la finestra Advanced.  

• Nel frame Content Type, selezionare le opzioni desiderate. 
 

Impos t a r e  C on t e n t  Th r e s h o l d s  c ome  p e r  Ra t i n g  Ag en c i e s  

• Cliccare . Selezionare . Viene visualizzata la finestra Advanced.  

• Nel frame Set Rating,  selezionare le opzioni desiderate . 

• Cliccare . Si possono personalizzare gli standard di rating attraverso tre standard Internazionali . 
 

Usare Filtro PopUp  

Ab i l i t a r e  F i l t r o  P opUp   

• Cliccare . Selezionare l’opzione Block Popup. 
 

Agg i ung e r e  S i t i  p e r  p e rme t t e r e  PopUp s  

• Cliccare . Nel frame White List, selezionare Add. Viene visualizzata la finestra Add to White List. 

• Inserire l’ URL dei siti per i quali si vuole abilitare i popup e cliccare OK. 
 

Ab i l i t a r e  t empo r an e amen t e  i  P opUps  

• Cliccare . Selezionare . Viene visualizzata la finestra Hot Key. 

• Selezionare l’hot key desiderato dal menu a discesa. Quando mantenete premuto questo tasto, i popups sono abilitati.  
 

Usare Browser Cleanup 

Av v i a r e  Op z i o n i  Au t o  E r a s e  /P r i v a c y  P r o t e c t o r   

• Cliccare . Selezionare il tab General. Selezionare l’opzione Run at System Startup o Run Everyday. 

• Nel frame Windows Auto Erase Options, selezionare le opzioni richieste. 

• Per avviare immediatamente Browser Cleanup, cliccare il pulsante Run Checked. I Links in tutte le aree selezionate nel paso 
precedente vengono rimossi . 

 

Assegnare diritti per  Remote Access File  

Ab i l i t a r e  d i r i t t i  p e r  Remo t e  A c c e s s  F i l e  

• Cliccare . Selezionare l’opzione Enable Remote Access File Rights.  
 

Con f i gu r a r e  d i r i t t i  Mod i f i c a  F i l e    

• Clicccare . Ci sono quattro frame nello schermo che permettono o negano agli utenti di modificare specifici tipi di files. 

• In un frame, inserire il tipo di estensione del file (es. .exe) nel campo in alto e cliccare Add. 
 

Abilitare Notifica agli utenti  

Ab i l i t a r e  I n v i o  d eg l i  A l e r t s   

• Cliccare . Selezionare l’opzione Show Alerts Dialog.. 

• Nel frame in basso, selezionare le opzioni per i vari Alerts. Gli alerts selezionati verranno inviati quando richiesto. 
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Canc e l l a r e  l e  Ma i l s  d a  u t e n t i  s p e c i f i c i   

• Cliccare . Nel frame Delete Mails From User, inserire e-mail ID. 

• Cliccare Add. Viene visualizzare la user ID nella finestra di visualizzazione. Tutte le mails da quell’utente verranno automaticamente 
cancellate . 

 

S e l e z i on a r e  Me s s a gg i  d i  No t i f i c a   

• Cliccare . Nella finestra Show Alert, selezionare i tipi di violazioni per i quali devono essere spediti i messaggi di mail di 
notifica . 

• I messaggi associati vengono visualizzati nella finestra in basso . E’ richiesta modifica.  
 

Inserire Chiavi di Licenza  

• Cliccare . Inserire la chiave di licenza nella finestra di dialogo visualizzata. 
 

Vedere  

Ved e r e  L og s  

• Nella tool bar, cliccare View > View Log File 
 

Help 

Camb i a r e  P a s swo r d  

• Nella tool bar, cliccare Help > Change Password 
 

Usare eScan Anti-Virus Monitor (AVM) 

Tasto destro su  e selezionare Monitor Settings > Enable eScan Monitor. Di default eScan AVM é abilitato e il link di popup visualizza 
l’etichetta Disable eScan Monitor. Se cliccate il link, eScan AVM viene disabilitato. 

Camb i a r e  Impos t a z i on i  d i  e S c a n  Mon i t o r   

• Tasto destro su  e selezionare Monitor Settings > eScan Monitor. 
 

S e l e z i on a r e  Ogg e t t i  d a  a n a l i z z a r e  

• In eScan AVM, cliccare . Viene visualizzato nel frame di destra l’albero delle directory di sistema .  

• Per selezionare gli oggetti su cui avviare la scansione , selezionare le opzioni adiacenti e cliccare così sui simboli  o  che 
appaiono . 

Impos t a r e  Op z i o n i  d i  S c a n s i on e   

• In eScan AVM, cliccare . Nel frame a destra vengono visualizzare le opzioni per la scansione .  

• Per selezionare le opzioni, selezionare le opzioni adiacenti e cliccare così sui simboli  o  che appaiono. 

• Cliccare  per sfogliare il vostro sistema per un file specifico o una cartella specifica. 

• Cliccare  per modificare i valori di pre-set delle opzioni. 
 

Pe r s on a l i z z a r e  e S c an  AVM 

• In eScan AVM, cliccare . Nel frame di destra vengono visualizzate le Opzioni di personalizzazione .  

• Per selezionare l’opzione, selezionare le opzioni adiacenti e cliccare così i simboli   o  che appaiono . 

• Cliccare  per sfogliare il vostro sistema per un file specifico o una cartella specifica. 
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• Cliccare  per modificare i valori di pre-set delle opzioni. 
 

De t t a g l i  d e l l ’ An a l i s i   

• In eScan AVM, cliccare . Nel frame di destra vengono visualizzati i dettagli della scansione . 
 

Un l o ad  e S c a n  AV  Mon i t o r  

• Nella toolbar di eScan AV Monitor toolbar, selezionare File > Unload eScan Monitor. 
 

Ved e r e  Opz i o n i  d i  e S c a n  AV  Mon i t o r    

• Nella toolbar di eScan AV Monitor, selezionare Monitor > View Monitoring Options 
 

La Console di Management di eScan 

eScan Management Console (eServ) funziona come un server centralizzato che vi permette di installare remotamente, distribuire gli updates e 
upgrades a tutte le macchine nella vostra rete, utilizzando i prodotti eScan. eServ esegue automaticamente il downloads degli aggiornamenti a 
predefiniti intervalli regolari da Internet e li rende disponibili a tutti gli utenti della vostra rete. Si può eseguire il deploy di Security policies e chiavi di 
licenza globalmente a tutte le macchine. Tutto ciò per assicurare uniformità, consistenza ed escludere errori umani . 

Tasto destro su  e selezionare Open eScan Management Console. La finestra ha due frames. Quello di sinistra mostra una lista dei client della rete. 
Il frame di destra mostra i task dell’attività di eServ. La Tool bar vi fornisce alcuni shortcuts per avviare azioni . 

S t a r t  Ann oun cemen t  

• Vi permette di informare tutti i client che gli aggiornamenti sono pronti e possono essere scaricati  

• In eServ, cliccare . Announcement viene avviato e gli eventi vengono visualizzati nel frame di destra  

• Per fermare gli avvisi, cliccare nuovamente l’icona  
 

Con f i gu r a t i o n  Hos t  

• Gli Hosts sono le machine (clients) in una rete sui quali volete installare   eScan 

• Nella tool bar, cliccare . Viene visualizzata una finestra di dialogo. Vengono mostrati i client esistenti . 

• Per aggiungere un host, cliccare Add Host/IP. Per rimuovere un host, cliccare sul nome dell’host e cliccare Remove Host/IP. 
Per cambiare le impostazioni degli host, cliccare sul nome dell’host e cliccare  Host Settings 

• Per includere l’host in auto install, cliccare Settings 
 

Dep l o y  L i c e n z a  

• Nella tool bar, click   

Dep l o y  d i  R eg o l e  

Rule-Sets sono security policies assegnate per per regolarizzare l’utilizzo di Internet nella vostra organizzazione. Sono create nel modulo Content 
Administrator. Potete eseguire il deploy globale delle impostazioni delle regole a tutti i client simultaneamente dal server .  

• Nella tool bar cliccare . Vengono visualizzate le opzioni Content Administrator. Selezionare le impostazioni delle regole che 
desiderate . 

• Per eseguire il deploy dei sets delle regole a tutti i clients , selezionare All Clients e cliccare Deploy 

• Per eseguire il deplou a specifici clients , select User Defined, scegliere i client s desiderati e cliccare Deploy 
 

Agg i o r n a r e  t u t t i  i  C l i e n t s  

• Nella tool bar, cliccare . Tutti i clients vengono aggiornati  
 

Av e r e  l o  S t a t o  d e l l ’ I n s t a l l a z i o nd e  d i  e S c an  

• Nel frame a sinistra selezionare il client. Nella tool bar, cliccare .  
 

Av e r e  l o  S t a t o  d e i  C l i e n t  a t t r a v e r s o  l ’ I P  

Questa caratteristica vi permette di selezionare i client per range di indirizzo IP e ottenere lo stato di installazione del software eScan e altri dettagli . 
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• Nella tool bar, cliccare . 
 

Con f i gu r e  l ’ i n v i o  i n  ma i l  d e i  R e p o r t s  

• Nella tool bar, cliccare . Viene visualizzata una finestra di dialogo. Ci sono due  tabs 

• Il tab Mail Configuration vi permette di insere l’email ID del report sender (mittente), il destinatario e IP/Port dei mail server che 
devono essere usati  

• Il tab Schedule vi permette di schedulare l’invio dei reports  
 

I n v i a r e  i  R ep o r t s  O r a  

• Nella tool bar, cliccare . I Reports vengono spediri ai destinatari (ID) specificati nel punto precedente  
 

Ved e r e  i  R e p o r t s  

• Nella tool bar, cliccare .  
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Contattaci 

Offriamo supporto 24x7 ai nostri customers attraverso e-mail, telefono e Chat. 

 

Supporto chat 

• Chatta con il nostro team di supporto a ‘escanchat’ con: AOL; o i servizi di messenger di MSN o Yahoo. 

Supporto E-Mail  

• Se avete qualsiasi domanda circa i nostri prodotti o avete suggerimenti e commenti riguardo questa guida, prego inviateli a 
support@mwti.net: 

 

Sede Centrale: 

MicroWorld Technologies Inc. 
33045 Hamilton Court East, Suite 105 

Farmington Hills, MI 48334-3385 

Tel: (248) 848 9081/ 848 9084 

Fax: (248) 848 9085 

Asia Pacific: 

MicroWorld Software Services Pvt Ltd.. 
Plot No 80, Road 15, MIDC, Marol, 

Andheri (E), Mumbai, INDIA. 

Tel (91) - 22- 28265701 - 05        

Fax (91) - 22-28304750                     

 

Per richieste di vendita, e-mail: sales@mwti.net 

Per richieste di supporto, e-mail: support@mwti.net 

 

 

Distributori eScan per l’Italia: 

   

        SATA HTS HI TECH SERVICES S.p.A. Sede legale: via Sinalunga, 57 - 00138 ROMA 

     Sede operativa: via Cjavecis, 3 - 33100 UDINE Tel +39 0432 499860 Fax + 39 0432 499831  

     Sede operativa: via Principale, 48 – 33010 INTERNEPPO DI BORDANO (UD) Tel +39 0432 979317 Fax +39 0432 979317 

     Sede operativa: via Padova 18 – 00161 ROMA Tel +39 06 45479085/6 Fax +39 06 45479087 

     http://www.sata-hts.com 

     

     Per informazioni: info@sata-hts.com 

     Per assistenza tecnica: help-escan@sata-hts.com 

 

 

 

 

 

 

 

 

 

 

 

 

 


